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1. Ustalenie sposobu wyswietlania danych w obszarze roboczym.
1.1.Uruchomié program Blender.
1.2. Ustawic¢ odpowiednie preferencje programu wciskajac , File” -> , User Preferences...” (Rys. 1, Rys.2). Osoby dysponujace laptopami bez wydzielonej ,bocznej”
klawiatury numerycznej powinny wcisngc przycisk ,,Emulate Numpad”. Wtedy funkcje ,bocznej” klawiatury numerycznej zostang przeniesione na klawisze z

cyframi w gérnej czesci klawiatury (Rys. 1).
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1.3. Wcisna¢ przycisk ,,Save User Settings”, co spowoduje zapamietanie ustalonego trybu pracy programu i wytgczy¢ panel do zmiany preferencji.
Uwaga: Opcja , File -> Load Factory Settings” przywraca domysIne ustawienia programu Blender.

2. Podstawowa obstuga programu Blender.
Prosze wyprébowac ponizsze operacje:

2.1.Klikna¢ lewym przyciskiem myszy w obszar roboczy pola.

2.2.W celu przyblizenia lub oddalenia sceny poruszac ,scrollem”.

2.3.W celu obrécenia sceny wcisng¢ ,,scroll” oraz przesungé¢ myszg.

2.4.W celu przesuniecia sceny wcisng¢ ,scroll”, przytrzymad klawisz ,Shift” oraz przesungé mysza.
2.5.Klawisze ,,1”, ,3”, ,, 7" to odpowiednio: widok z przodu, widok z boku i widok z gory.
2.6.Klawisz ,,0” to widok z kamery (lub odwrotnie).



2.7.Klawisz ,,5” to zmiana rzutu prostopadtego na perspektywistyczny (lub odwrotnie).
2.8.Klawisze ,2”, ,4”, ,6", ,8” to obracanie sceny w rézne strony.

Podstawowe modyfikacje obiektéw na scenie.
Prosze wyprdébowac ponizsze techniki pracy na grupach wierzchotkdw:

3.1.Program Blender pracuje w dwu podstawowych trybach: trybie obiektu (,,Object Mode” - komponowanie sceny z obiektéw) oraz trybie edycji (,Edit
Mode” - modyfikowanie wybranego obiektu). Zmiana pomiedzy tymi trybami odbywa sie poprzez wcisniecie przycisku , TAB”.

3.2.W trybie , Edit Mode” mozna zaznaczy¢ grupe wierzchotkéw siatki przez klikanie poszczegdlnych wierzchotéw podczas przytrzymywania klawisza ,,Shift”.

3.3.Zaznaczenie/odznaczenie wszystkich wierzchotkéw odbywa sie przez wcisniecie klawisza ,A”.

3.4.Cofniecie operacji odbywa sie za pomocag kombinacji klawiszy ,Ctrl” +,Z".

3.5.Zaznaczone grupy wierzchotkéw mozna poddac nastepujacym transformacjom:

- przesuniecie: wcisngc klawisz ,,G”, a nastepnie ,X”, ,Y” lub ,Z” (odpowiednio wzdtuz osi X, Y lub Z), po czym przesungc¢ myszg. Wybrane przesuniecie grupy
wierzchotkéw zatwierdza sie kliknieciem lewego przycisku myszy.

- rotacja: wcisng¢ klawisz ,,R”, a nastepnie ,X”, ,,Y” lub ,,Z” (odpowiednio wzdtuz osi X, Y lub Z), po czym przesungé myszg. Wybrane obrdcenie grupy
wierzchotkéw zatwierdza sie kliknieciem lewego przycisku myszy.

- skalowanie: wcisng¢ klawisz ,,S”, a nastepnie ,X”, ,Y” lub ,,Z” (odpowiednio wzdtuz osi X, Y lub Z), po czym przesungé myszg. Wybrane skalowanie grupy
wierzchotkéw zatwierdza sie kliknieciem lewego przycisku myszy.

- wycigganie: wcisng¢ klawisz ,,E”, a nastepnie ,, X", ,Y” lub ,,Z” (odpowiednio wzdtuz osi X, Y lub Z), po czym przesungé myszg. Wybrane wyciggniecie grupy
wierzchotkéw zatwierdza sie kliknieciem lewego przycisku myszy.

3.6. W trybie edycji (,Edit mode”) mozna podzieli¢ dang siatke przez przeciecie jg pewng ptaszczyzng podziatu. Na przecieciu ptaszczyzny i siatki zostang utworzone
nowe wierzchotki. W celu aktywowania podziatu nalezy wcisngé kombinacje klawiszy ,,Ctrl” + ,,R”. Podczas przemieszczania kursora po siatce zostang
zaproponowane mozliwe ptaszczyzny podziatu. Po kolejnym kliknieciu nastepuje zatwierdzenie podziatu.

3.7.Tworzony projekt na kazdym etapie mozna zapisac do pliku ("File" -> "Save/Save as").

Tworzenie siatki.

4.1.Prosze utworzy¢ nowy projekt wciskajac ,File” -> ,New”, a nastepnie wciskajgc ,Enter”. Mozna to rowniez zrobi¢ za pomocg kombinacji klawiszy ,,Ctrl” + , N”.

4.2.Najechac na ikonke w prawym gérnym rogu miedzy obszarem roboczym a menu (Rys. 3 — 1.), wcisng¢ jg i przeciggngé¢ w lewo do potowy obszaru roboczego.
Obszar roboczy jest teraz podzielony na dwa podobszary (Rys. 3). Zminimalizowaé menu dzielgce podobszary poprzez przesuniecie jego krawedzi (Rys. 3 —2.).

4.3.W lewym podobszarze wybraé widok z przodu (klawisz ,,1”).

4.4.W prawym podobszarze wybra¢ widok z boku (klawisz ,,3”).

4.5.W lewym podobszarze zaznaczy¢ tryb edyc;ji (,,Edit Mode”)(Rys. 3 —3.).
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4.6. Domysling siatke (szescian) nalezy dwukrotnie wydtuzy¢ wzdtuz osi Z (kolejno: klawisze ,,S” i ,Z”, przesuniecie myszki, zatwierdzenie zmian LPM)(Rys. 4)
4.7.Domyslng siatke (szescian) nalezy dwukrotnie zwezi¢ wzdtuz osi Y (kolejno: klawisze ,S”i,Y”, przesuniecie myszki, zatwierdzenie zmian LPM)(Rys. 4).
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4.8.W lewym podobszarze dokonaé przeciecia siatki ptaszczyzng rdwnolegtg do ptaszczyzny ZY (klawisze ,,Ctrl” +

»R”). Przeciecia dokona¢ w sposdb niesymetryczny.
Prawa czes¢ siatki powinna by¢ mniejsza od lewej (Rys. 5).
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4.9.Zaznaczy¢ wierzchofki siatki nalezace do lewej bocznej $ciany siatki (LPM + ,,Ctrl”)(Rys. 6).
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III

4.10. Usunac zaznaczone wierzchotki wciskajac klawisz ,Del” i wybierajgc z menu kontekstowego opcje ,Vertices” (Rys. 7).
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4.11. Zaznaczy¢ wszystkie wierzchotki siatki (klawisz ,,A”)(Rys. 8).
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4.12. Utworzy¢ dla obiektu modyfikator — lustro wciskajac kolejno ikonke "Modifiers" (Rys. 9 — 1.) na prawym panelu, "Add modifier" -> "Mirror" (Rys. 9 —2.).
Nastepnie zaznaczamy opcje "Clipping", ktéra pojawi sie w panelu.
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4.13. Przesungc siatke do lustra (klawisze: "G", "X", przesuniecie myszki, klikniecie LPM), aby odbicie i oryginat "zlaty sie" w prostopadtoscian (Rys. 10).
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4.14. Dokonaé przeciecia siatki (klawisze "Ctrl" + "R") dwoma ptaszczyznami — jedng réwnolegta do ptaszczyzny ZY, drugg réwnolegtg do ptaszczyzny XY w takich
proporcjach jak pokazano na rysunku (Rys. 11) (Dla siatki w prawym oknie zastosowano widok przezroczysty — klawisz "Z").
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Zaznaczy¢ wskazany na rysunku wielokat (Rys. 12).
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Zaznaczony wielokat dwukrotnie "wyciggna¢" (klawisze: "E", "X", przesuniecie myszy, klikniecie LPM), aby uzyskac siatke jak na rysunku (Rys. 13).
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W podobny sposéb wyciggnac z odpowiedniego wielokata "nogi" (Rys. 14).
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4.18. Zaznaczy¢ wielokat jak na rysunku i potraktowac go jako miejsce, w ktérym zaczyna sie "szyja" (Rys. 15).
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4.19. Poprzez kolejne transformacje wyciggania ("szyja" — klawisze: "E", "Z", przesuniecie myszy, klikniecie LPM; "1/3 gtowy" - klawisze: "E", "Z", przesuniecie
myszy, klikniecie LPM) i skalowania (klawisze: "S", "X", przesuniecie myszy, klikniecie LPM) mozna uzyska¢ 1/3 modelu gtowy. Wykonujgc kolejne wyciggniecie,
wyciggniecie i skalowanie nalezy samodzielnie dokonczy¢é modelowanie gtowy (Rys. 16).
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4.20. Zaznaczy¢ wszystkie wierzchotki siatki (klawisz "A") w celu wygtadzenia jej, a nastepnie poddac siatke modyfikatorowi o nazwie "Subdivision Surface" (Rys.

17). W panelu modyfikatora ustawi¢ poziom wygtadzania na "View: 2".
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4.21. Przejsé do trybu pracy na obiektach ("Object mode") i zatwierdzi¢ dziatanie zastosowanych modyfikatoréw poprzez nacisniecie przyciskow "Apply" w
panelach modyfikatoréw (Rys. 18).
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Tworzenie szkieletu.
5.1.Uzywajgc PPM umiesci¢ kolorowy celownik "wewnatrz siatki" na wysokosci krocza. W tym miejscu zostanie wtgczony do sceny nastepny element sceny —
szkielet. Nastepnie nacisngc "spacje" i z menu kontekstowego wybraé "Add" -> "Armature" (Rys. 19).
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5.2.Aby nowo dodana kos¢ byta widoczna nalezy wtgczy¢ w panelu "Armature" przycisk "X-Ray" (Rys. 20). Na scenie znajdujg sie teraz 2 obiekty, ktore stworzylismy:
siatka i pierwsza kos¢ szkieletu.
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5.3.Klikng¢ LPM w kos$¢ i przejs¢ do trybu edycji szkieletu ("Edit Mode"). Stosujgc metode wyciggania (klawisze: "E", "Z", przesuniecie myszy, klikniecie LPM) nalezy
z pierwszej kosci "wyciggnac" kregostup postaci (Rys. 21).
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5.4.Korzystajac z PPM umiesci¢ kolorowy celownik "wewnatrz siatki" w miejscu, gdzie powinna by¢ zaczepiona ko$¢ ramienia. Wcisngc¢ "spacje" i z menu
kontekstowego wybrac "Add" -> "Bone" (Rys. 22). Ko$¢ mozna umiejscowi¢ w ramieniu.

Blender Render ¥ el

Front Ortho Right Ortho

Add Boid Rule
Add Boid State
Add Brush

Add Bezier Circle
Add Bezier

Add Background Image (Ctrl for Empty Cbject)

(0) Amnature : Bone.003 (0} Armature : Bone.003
W Edit Mode % 2+ I0 v = 0 ¥ EditMode v @ ¥

e =51 F=) = R No Sync = ® tgy_??




5.5."Wyciggnac" z kosci ramienia jeszcze jedng kos¢, decydujacg o ruchu przedramienia (Rys. 23).
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5.6.Kosci przedramienia i ramienia nalezy logicznie potgczy¢ z kregostupem. Zaznaczy¢ kos¢ ramienia, a nastepnie trzymajac klawisz "Shift", zaznaczy¢ jedng z kosci
kregostupa. Wcisng¢ klawisze "Ctrl" + "P" i wybrac "Keep offset". Przerywana linia oznacza logiczne potgczenie miedzy kos¢mi (Rys. 24).
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5.7.Klikng¢ kos¢ ramienia, wybraé¢ w panelu po prawej stronie zaktadke "Bone" i zmieni¢ nazwe kosci na "Rekal.L". To samo zrobi¢ dla kosci przedramienia, ale
nazwe zmienic¢ na "Reka2.L" (Rys. 25).
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5.8.Zaznaczy¢ obie kosci reki (LPM + "Shift"). Nastepnie wcisng¢ kombinacje klawiszy "Shift" + "D", ktora zduplikuje zaznaczone kosci. Przesunaé nowe kosci w
prawo, aby znalazty sie obok siatki (Rys. 26).
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5.9.Przy zaznaczonych zduplikowanych kosciach wybra¢ z dolnego menu opcje "Armature" -> "Flip Names" (Rys.27). W rezultacie nazwy zduplikowanych kosci
zostang zmienione na "Rekal.R" oraz "Reka2.R".
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5.10. Przy zaznaczonych zduplikowanych kosciach wybra¢ na dolnym pasku przycisk "Armature" -> "Mirror" -> "X Local". Nastepnie przesuna¢ kosci tak, aby ich
potozenie byto odwzorowaniem kosci lewej reki (Rys. 28).
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5.11. Przejs¢ do trybu obiektéw ("Object mode"). Zaznaczy¢ catg siatke oraz szkielet (klawisz "A"). Nastepnie nacisng¢ kombinacje klawiszy "Ctrl" + "P" i wybrac z
menu kontekstowego "With Automatic Weight". Szkielet jest teraz logicznie potgczony z siatkg (Rys. 29).
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5.12. W trybie obiektéw zaznaczyc szkielet. Nastepnie przetaczyé tryb na "Pose Mode". Zaznaczy¢ jedng kos¢ (zostanie zaznaczona na niebiesko) i wykonaé naniej
operacje rotacji (klawisz "R"). Siatka powinna znieksztatcac sie pod wptywem modyfikacji potozenia kosci (Rys.30).
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Tworzenie animacji.
6.1. Wyjsciowg pozg jest ta, ktdra powstata po potaczeniu szkieletu z siatkg. Zawarto$¢ prawego podokna przetgczy¢ w dolnym pasku na "Dope Sheet", a nastepnie
"Action Editor" (Rys. 31).

op| &% Blender Render ¥ A

Fromnt Ortho I All Scenes

Python Console

File Browser

Irfo
B4 User Preferences
Outliner

Properties

Logic Editor
J Node Editor
Text Editor

> Movie Clip Editor
Video Sequence Editor

= UWlmage Editor

NLA Editor

Graph Editor
Adjust timing of keyframes
Timeline

(0) Amnature : Reka2 L 3D View
Wrosemode ;| @ 7| % 7[5 MM clobal 55 w2l @ ActionEditor  + | 2 Summary

\‘Stat: 1] ‘End:  250F LY 0, S[BERI Y| No Sync o) s &R




6.2.Zaznaczy¢ wszystkie kosci na modelu postaci (klawisz "A"). Wcisngé klawisz "i" po czym wybrac z menu kontekstowego "LocRotScale". W oknie "Action Editor"
pojawi sie teraz spis kosci wraz z symbolicznie zanotowang pierwszg klatkg animacji (Rys. 32).
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6.3.W oknie "Action Editor" z zastosowaniem PPM wskazaé nastepng klatke kluczowsa, ktérg zamierza sie zdefiniowac. W oknie siatki zmodyfikowac ustawienie
wybranych kosci, a nastepnie ponownie wykonaé zadanie z punktu 6.2. Wykonujac cyklicznie polecenia z punktow 6.2.-6.3. mozna zanotowac ustalong
sekwencje ruchow (Rys. 33).
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6.4.Uruchomié animacje poprzez wcisniecie przycisku jak na obrazku (domysina ilo$¢ wyswietlanych klatek animacji to 250, stad krétsze animacje bedg wyswietlane
"co pewien czas") (Rys. 34).
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